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Huntron Workstation Software Tutorial for Tracker 3200S 
It is very helpful if you have a working knowledge of Microsoft Windows prior to using 

Huntron Workstation. 

You are allowed to create a backup copy of the software disk. Your purchase 

agreement allows for copies to be made for backup purposes only- copying for 

distribution or resale is strictly prohibited.  

 

Installation Instructions 

Refer to the Getting Started document included with the Tracker 3200S for complete 

instructions on software installation. 

Uninstall any previous versions of Workstation prior to installing the new version. 

Insert the Huntron Workstation DVD. The DVD should Autorun and begin the 

installation process. If your PC has Autorun disabled then open a browse window to 

the CD and select WorkstationSetup.exe. This will begin the installation process. 

During the install you will be asked to install additional software for Access Probers. 

Answer NO to these questions if you do not have an Access Prober. 

If you purchased CAD Tools then install using the supplied CD. Follow instructions 

listed in the CAD Tools Tutorial. 

If you are using Workstation in conjunction with a digital multimeter, follow the 

instructions listed in the Workstation DMM Tutorial. 

All of the Workstation tutorials are available on the Huntron web site: 

www.huntron.com/sales-support/software.htm 

http://www.huntron.com/sales-support/software.htm


© Huntron, Inc 2019 Version 3 3 

Huntron Workstation Main Interface 

When starting Huntron Workstation for the first time, you will be prompted for an 

activation code. Type in the code exactly as it is presented on the installation CD. 

Huntron Workstation 4 has built-in conversion utilities that enable conversion of board 

tests created in 3.X versions of Huntron Workstation. 

 

 

The Main Window for Huntron Workstation 4 features a multi-pane layout so many 

aspects of the test creation and execution can be displayed at the same time. The 

Panes are interactive to a certain degree in that changes in one Pane will affect other 

Panes. The Panes can be resized, floated independently or “tabbed” to the sides of the 

window. The Status Bar displays information about items currently selected and status 

information while processes are running. 
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Prober Pane 
- Robotic Prober 
control 

Image Pane 
- Display of CAD 
layout and PCB 
images 

Status bar 

Tool bars 



© Huntron, Inc 2019 Version 3 4 

The Toolbar 

The Toolbar just under the application menus allows for quick access to several 

program functions. The function of each is broken out in the diagram below. 

 

 

 1. 2. 3. 4. 5. 6. 7.  8.  9. 10.  11. 12. 13. 14. 15. 16. 17. 18. 19. 

 

1. Create New Board database 11. Scan Component or Net 

2. Open Board database 12. Scan Sequence 

3.  Save As… 13. Send Prober head to Home position 

4. Add New (Sequence, Component or Range) 14. Connect/Disconnect Prober 

5. Copy (Sequence, Component, Net or Range) 15. Connect/Disconnect Tracker 

6. Paste (Sequence, Component, Net or Range) 16. Previous Component or Net 

7. Cut (Sequence, Component, Net or Range) 17. Next Component or Net  

8. Delete (Seq., Comp., Net, Range or Scan) 18. Previous Pin 

9. Build New (Sequence, Component) 19. Next Pin 

10. Repeat New (Sequence, Component) 

 

Hardware Setup 
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When first starting Huntron Workstation, select Options from the Tools menu. The 

Options window is used to setup default settings used when working in Huntron 

Workstation.  

For this tutorial, the Tracker 3200S will be referred to in general as “Tracker”. 

 

 

 

Select Options from the Tools menu. Select the Hardware tab and set the type of 

Tracker hardware as Tracker 3200S and the Tracker Port as USB.  Disregard the 

Prober settings on the right side of the window. 

 

Click the Connect button to initiate communication with the selected hardware. Once 

connected, the button changes to Disconnect. Click the Save (Permanent) button 

to save this configuration as the startup default.  

 

Using a Tracker 3200S 

The Tracker 3200S comes from the Factory calibrated for standalone use. If the 

Tracker 3200S is connected to a Prober or through other cabling connected to the 

Scanner connections then calibration must be performed.  

- Select Tools/Maintenance/Tracker 3200S Diagnostics from the menu. 

Click the Alignment button the Tracker 3200S Diagnostics window. When the 

Alignment procedure finishes (about 10 minutes), run Verify Alignment. This also 

takes about 10 minutes to complete. The Alignment information is stored in the 
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Tracker 3200S and will be used by the software. If changes are made to the cabling or 

attached instruments, simply run Alignment and Verify Alignment again. 

 

Manual Modes – Tracker and Scanner 

     

You may find it useful to manually test some of your components while adjusting the 

range parameters. The two manual modes, Tracker and Scanner located in the 

Signatures pane, can work together to display the signature of a component pin. 

Tracker mode sets the range parameters, channel, tolerance, footswitch and Pulse 

Generator settings. Signatures will be displayed to the right while probing with hand-

held probes (select the Realtime check box). The Hold button will capture and hold 

the current signature allowing for quick comparisons. The Clear button will clear the 

“held” signature. 

The Pulse Width, Pulse Level, Pulse/DC settings control the G1 and G2 outputs on 

the Tracker 3200S front panel. These outputs can be used to bias gated devices such 

as relays, SCRs and TRIACs. 

Scanner mode allows you to use a Tracker 3200S Scanner connections to interface to 

the component pins. You can set the package type, number of pins and common pins. 

The Scan button starts a hands free scan of the component through the scanner cable 

interface or you manually increment the pins with the << and >> buttons. The Hold 

button will capture and hold the current signature allowing for quick comparisons. 

Manual modes are for real time display only and does not allow for permanent 

signature storage. To store signatures you will need to create a Board Test. 
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Creating a Board Test 

There are a number of steps necessary to creating a board test. 

 

Workstation Tree Structure 

- Board (created Huntron Workstation (.hwdb) database file) 

- Sequence (Test set of Components) 

- Component or Net (name) 

o Pins (name, channel) 

o Ranges (V, F, R range settings) 

 

Example of Board Test Information: 

Board Name: Main Board (creates “main board.hwdb” file) 

 Revision: Rev. A (This field is optional) 

Sequence: IC’s  

Component: U27 (component name) or A2 (NET name) 

Pins: per pin settings for Scan Pin setting, channel, net name, etc… 

Ranges: Per pin settings for common reference pin, tolerance, etc… 

The user has total discretion as to the information input into these fields. There is no 

“right” way as to what information is entered as every user’s situation will be different. 

The above example is just one way the information might be entered. 

Entering information into the Entry windows is very straight forward. The easiest way 

to move from field to field is by pressing the TAB key. You can also use the mouse to 

click into a particular field so you can enter information. 

 

  



© Huntron, Inc 2019 Version 3 8 

Converting a Test Created in Workstation 4.2 

Workstation 4.3 uses a different database type than version 4.2. To update a version 

4.2 test to work in version 4.3, select Open from the File menu. In the Open window, 

select .MDB from the file type drop menu. Select the .MDB test file name and click the 

Open button. 

 

 

Click the Convert button to create the new test for version 4.3. The conversion can 

take some time based on the original test size. 

 

 

 

Click the Close button when the conversion is complete. The updated test will be 

opened in the Workstation interface.  
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Building Procedures for a New Test  

- Create Test Database in the Tree Pane 

o Add Board, Sequence, and Components before teaching or scanning 

- Scan Components and Set References (Tracker only or Tracker/Scanner users) 

 

Listed above is a general outline on how you would proceed when preparing to test a 

board. These guidelines apply to all package types and boards. As with any type of 

complex test equipment, practice makes perfect so take the time to learn and practice 

these procedures.  

 

Creating a Board Database 

 

 

 

To create a new Board, select New from the File menu or use the New button in the 

toolbar. Input information into the “Add New Board” dialog as needed. The only field 

that is required is board Name. Other fields such as Revision, System, Unit, 

Manufacturer, Test Routine Number can be completed with related information if 

desired. Instructions can be added in the Instruction field now or added later. 
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Adding a New Sequence 

 

 

 

To add a new Sequence, select the Sequence tab in the Tree pane. Select Add New 

Sequence from the Edit menu or click the Add New button (+) in the toolbar. 

Primary Details: 

Sequence Name Field: Enter Sequence name 

Compare Priority: Selects the comparison priority of signatures to Reference 

signatures between Same (serial number as Reference), All (All References; this is 

the recommended setting) or Merge (Merged min/max signatures) 

Slot: This selection is used with Access Probers. 

Type: Components or Nets. Select Components for most tests as Net tests are 

usually created using CAD data. 

Side: This selection is used with Access Probers. Top is the default. 

Instructions field: Enter any instructions or system information that you wish to 

pass on to future users. Note: the ENTER key in this field will work as a carriage 

return. 

The Delete Scans button will erase all scans stored under the Sequence. 

 

Other functions within this window can be read about by clicking the HELP button. 

 

 

 

 



© Huntron, Inc 2019 Version 3 11 

 

Adding a New Component 

Component Package Types 

 

 

 

When adding a new component to your test the package type determines how the 

front panel Scanner connection pins are counted. The available Scanner packages are 

Both, DIP, Front, Probe (uses manual test probes), SIP, DIP2X (combines the A 

and B channels for 128 pins) and SIP2X (combines the A and B channels for 128 

pins). There are other packages listed (i.e. Multi, Cable) in the Package drop menu 

that are used with other Huntron hardware. 

 

 

 

 

 

 

 

 

 

 

Tracker 3200S scan 

packages are BOTH, DIP, 

FRONT, MULTI (used with 

Probers only), PROBE, SIP, 
DIP2X, and SIP2X 



© Huntron, Inc 2019 Version 3 12 

To add a new Component, select the Component tab in the Tree pane. Select Add 

New Component from the Edit menu or click Add New button (+) in the toolbar. 

 

 

 

Details: 

Component Name field: Enter the component name (reference designator) in this 

field.  

Package and Number of Pins fields: Using the mouse, click on the down arrow to 

the right of the field to bring up the pull-down menu. Select the package type and 

number of pins from these menus. 

Type field: This information is optional but you can enter the component type in this 

field.  

Connection Type: Select the type of hardware used to interface to the component. 

Select Probes if manual probes will be used or Scanner if the front panel Scanner 

connections will be used. 

Instructions field: Enter any instructions or component information that you wish to 

pass on to future users.  

Other functions within this window can be read about by clicking the HELP button. 

Click the OK button to close the Edit window. 
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Tree/Pin Tab 

Once a component is added to the Workstation Tree, switching to the Pin tab will 

display information for each pin of the selected component. 

 

Text in the Name field can be modified directly by clicking in the text field and typing 

the new name. The Scan Pin setting enables or disables scanning of the pin. Pause 

will cause the scan to pause when the selected pin is reached. The Channel field 

controls which channel (A or B) is used. Controls for the Tracker Pulse Generator can 

also be controlled at the Pin level. These control include Pulse Type (polarity), Pulse 

(on/off), Pulse Level (amplitude) and Duty Cycle (up to 50% on pulsed signals). 

Consult the Tracker 3200S User’s Manual for how the Pulse Generator is used.  

Information on the other settings in the Pin tab is available in the Workstation Help. 
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Adding a New Range 

 When a new component is added to a Sequence the ranges used are set by the 

defaults set up in the Tools/Options/Ranges tab. It is best to set up your desired 

default ranges before adding Components to your Sequence. 

  

In the Range/General tab, enable the number ranges and set the tester type as 

Tracker (default). In the Ranges tab, set the Voltage, Resistance and Frequency range 

parameters. These are the ranges that will be used when adding a new Component. It 

does not change existing Components. On a new software installation these defaults 

set three ranges – 3V, 50Kohms at 500Hz; 3V, 1Kohms at 200Hz and 3V, 50 

ohms at 60Hz. In general use, these three ranges will work well but you may need to 

add or modify ranges based on component type and value. As a general reference, the 

table below can be used to assist you in setting ranges. 

ranges. 

 

 

 Range 

Impedance 

Voltage> 
200mV 

 
3V 

 
6V 

 
10V -15V 

 
20V 

 10 - 100 continuity, 
shorts, caps, 
resistors & 
inductors 

low 
impedance 

components 

newer MOS 
ICs 

power supply 
& regulators 

 

 1K - 10K resistive 
faults 

latest MOS & 
surface 
mount 

ICs 

newer MOS 
ICs 

older MOS ICs  

 20K resistive 
faults 

resistive 
faults 

older MOS 
ICs 

TTL 74XXX  & 
74LSXXX ICs, 
older MOS Ics 

TTL 74XXX  
ICs, power 
transistor 

 100K resistive 
faults 

resistive 
faults 

resistive 
faults 

resistive faults Hi resistance& 
Hi power 
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The Tracker signatures are shaped based on the Tracker range settings. The basic goal 

is to achieve signatures that are halfway between open and short. The signatures for 

the four basic types of components shown below illustrate this primary goal. 

 

 

 

 

 

 

 

 

 

 

 

 

To add a new Range, select the Range tab in the Tree pane. Select Add New Range 

from the Edit menu or click the Add New button (+) in the toolbar. A pop-up dialog will 

Select the Tree/Range tab to display 
the ranges for the selected 
component pin. RIGHT click on the 
row header (far left grey area of the 
row) to display a quick menu (shown 

left) 

Resistance 

Capacitance 

Inductance 

Semi-conductance 
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ask where you want the new range to be added. Select the desired radio button (All 

Pins is generally the desired selection) and click OK. 

Add New Range Details: 

Note: Voltage/Resistance/Frequency can be modified directly in the Range grid.  

Voltage/Resistance/Frequency fields: Select the desired range settings 

Max Samples/Tolerance/Delay: Select the setting to be used when scanning this 

range 

Common Pin: Select Scanner common pins to be used when scanning this range. 

Scanner users wishing to use a particular component pin (i.e. ground pin) for Common 

should select the Common pin at this time using the Common Pin 1 field (the 

Common Pin 2 field is rarely used). 

 

Note: It is easier to set up the ranges used by selecting Tools/Options/Range from 

the Tools menu in the menu bar and pre-configuring the default ranges. 
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Scanning with a Tracker 3200S 

To scan an entire Sequence, select the Sequence in the Tree/Sequence tab or enable 

the Sequence checkbox in the Scan tab. To scan an individual component, select the 

component in the Tree/Component tab.  

Select the Scan tab in the Signatures pane and input a Serial Number then click the 

Start button.  

 

 

 

You will be prompted to connect to the component. Tracker with Scanner users should 

connect to the selected component at this time.  Click OK to initiate the Scan. 
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If you are performing Sequence scan you will be prompted to continue to the next 

component until all of the components in the Sequence have been scanned. 

If a Tracker with probes is being used your will prompted to connect to pin 1 of the 

selected component (if performing a single component scan) or of the first component 

in the Sequence (if performing a Sequence scan). Click the OK button to scan the first 

pin. You will then be prompted to move to the next pin for scanning. Click OK to scan 

and continue in this manner until all of the component pins are scanned. At anytime 

during scanning you can click the Previous Pin button to go back and rescan the 

previous pin.  

 

 

Once all pins are scanned click the OK button to continue. 

When the Sequence or Component scan is complete the Scan Results window will be 

displayed. Go to the Scan Results section of this tutorial for more information on 

what to do after scanning. 

If the Tracker Scanner connections are being used (i.e. DIP clip and cable) you will be 

prompted to Connect to the Component before the scan is executed. Connect the 

Scanner cable to the component to test and click OK to start the scan. Once the scan 

is complete, the Scan results will be displayed. 
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Click the 

Troublesheet 

BUTTON to view 
latest scan results! 

Scan Results 

 

 

When a scan is complete, the results NO REF, PASSED or FAILED will be displayed (the 

text of the PASSED or FAILED message can be changed in the 

Tools/Options/General settings). The NO REF message will be displayed on the first 

scan of any test since there are no signatures stored as a comparison Reference. 

Clicking the Troublesheet button will display the signature from the last scan in the 

Troublesheet tab of the Signature pane.  

Note: Selecting the Troublesheet tab will display Troublesheet information from the 

previous scan. 

 

The first NO REF scan will display signatures in red with orange text. Review the 

signature at this time. If the signatures meet your approval (always use a known good 

PCB) click the Set Reference button to mark these signature as a comparison 

Reference. The text will change to green when set. 
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Viewing Signatures – Troublesheet 

Once a test has reference signatures stored, subsequent scans will compare to those 

references. The test results will be either PASS or FAILED.  

 

Click the Troublesheet button to see the test results. 

When a scan is executed and compared to the Reference signatures, the current scan 

signatures (in red) will overlay the reference signatures (in green). 

  

 

Components that fail comparison will be listed under the Failed tab. Components that 

pass comparison will be listed in the Passed tab. You can remove components from the 

list by clicking the Remove button where they will be moved to the Removed tab and 

not included in any Troublesheet reports. Use the vertical scroll bar to scroll through 

the scanned pins. Use the horizontal scroll bar to scroll the pin ranges especially if 

the viewing is set to Pin mode (see Viewing Signatures – Right Click section). 

 

Double click to zoom signature. Double 
click zoomed signature to un-zoom 
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Viewing Signatures Troublesheet Report 

To view and print the Troublesheet report, press the Print button in the Troublesheet 

window. 
 

    

You can select from several options including a Sequence or Component Level report, 

the level of detail and add problem and solution comments to the report. Click 

Preview to view the report on-screen. 

 

 

The report can be printed or exported in several different formats including HTML and 

PDF by selecting File/Export Document in the Preview window. 
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Viewing Signatures in the Signatures Pane 

 

 

To view scanned signatures of the component selected in the Tree pane/Components 

tab, select the Signatures tab in the Signature Pane. The Scan name, date and time 

will be displayed on the left side of the window and signatures on the right. The Scale 

buttons will change the number of columns displayed. Scaling the window will increase 

the number of signatures displayed. The Copy button will copy the signatures to the 

Windows clipboard so they can be pasted into another program (in a metafile format). 

The Print button will print the signatures in one of several different user selected 

formats. The Troublesheet button will switch to the Troublesheet tab and display the 

Troublesheet of the scan selected in the Scan List. You can use the keyboard Shift and 

Ctrl keys to select and stack signatures in the signature boxes (shown above). The 

signatures will be displayed in contrasting colors and can be very useful if you want to 

make general comparisons among different scans. 
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Viewing Signatures – Right Click 

 

 

Additional options when viewing signatures can be displayed by right clicking in the 

signature area. 

Reprobe Pin Signatures: Capture signatures for all displayed ranges and prompts to 

replace signatures immediately – available in Range mode only 

Real Time: Display signature in real time 

Get Signature: Capture signature for selected pin and range 

Get Pin Signatures: Captures signature for all ranges – works only in Range Mode 

Replace Signature: Replaces the current signature with the captured signature 

displayed for the selected pin, range and scan (shown in the Scan List to the left) 

Replace Pin Signatures: Replaces the current signatures with the captured 

signatures displayed for the selected pin, all ranges and scan – works only in Range 

Mode 

Sync Pin/Range: Selects pin and range in the Tree (see default in Tools/Options) 

Edit Range: Selects the pin and range in the Tree and opens the Edit Range dialog 

Disable Range: Disables the selected range (set in the Tree pane, Ranges tab) 

Edit Pin: Selects the Pin the in the Tree and opens the Edit Pin dialog 

Edit Comp/Net: Shortcut to the selected Component Edit dialog in the Tree pane 

Group Edit: Opens Group Edit dialog for editing of component pin parameters as a 

group 



© Huntron, Inc 2019 Version 3 24 

Net Edit: Opens Net Edit dialog for editing of Net pin parameters as a group 

SigAssist: Displays the SigAssist window showing calculated approximate values of 

resistance, capacitance, breakdown voltage, etc. based on signature information 

Sync CAD: Will link the selected signature to the CAD image displayed in the 

Image/CAD pane. Sync CAD will be disabled if there is no linked CAD data. 

Sync Image: Links current Troublesheet to the image in the Image pane/Image tab  

Copy: Places the signature image in the clipboard 

Data: Displays the signatures numeric data 

Range/Pin Mode: Displays signatures with Range priority or Pin priority - see default 

in Tools menu/Options/Signature tab) 

Find: Searches for a specific component in the Troublesheet list. 

 

View SigAssist Information 

 

The SigAssist window can be viewed by right-clicking on a displayed signature and 

selecting SigAssist. It appears as an additional pop-up window. The information 

presented relates to the individual scans displayed in the signature. The calculated 

resistance, capacitance, power, forward breakdown voltage (Fbd), reverse breakdown 

voltage (Rbd), maximum voltage and maximum current are displayed. These values 

are for troubleshooting purposes only and are not intended to be used as true 

measurements. The accuracy of the SigAssist values depends greatly on the scanned 

signature information. SigAssist values may not be calculated for signatures that do 

not contain enough information for reasonable calculations to take place (i.e. opens, 

shorts). The Copy button will put a copy of the window into the clipboard for use in 

other programs. 
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Component Scans Information 

 

 

Selecting the Component Scans tab in the Tree Pane will display all of the scans 

performed on the selected component in a table format. The Scan information 

displayed includes the serial number, operator, date/time, Merge setting (checked if 

this scan is included in the Merge set), Reference setting (checked indicates it is set as 

a comparison Reference), Pass status (will be checked if components passed 

comparison), Removed status (will be checked if component was removed from 

Troublesheet), Area number (highest of scanned pins), Deviation, Min/Max status and 

other settings (see Help for more information). 

 

 

 

 

 

 

 

 

 

 

 

 

 



© Huntron, Inc 2019 Version 3 26 

Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Row bar of the Component Scans tab displays an additional menu 

for performing specific tasks such as enabling/disabling References, deleting a scan for 

the selected components or all components and loading a Troublesheet. Enable 

Sequence Reference will mark the scan as a Reference for the entire Sequence. 

Disable Sequence Scan will disable the selected Sequence as a reference. Delete 

Scan will erase the selected scan for the current component only. Delete Scan All 

Components/Nets will erase the selected scan for all components or nets in the 

Sequence. 

Load Troublesheet will display the selected scan in the Signatures/Troublesheet 

pane. 

 

 

 

 

 

 

 

 

 

 

 

 



© Huntron, Inc 2019 Version 3 27 

Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Column bar of the Component Scans pane displays an additional 

menu for performing specific tasks such as sorting or globally setting parameters. The 

menu will vary depending on the column selected. In the image above, the Reference 

column header was right-clicked. 

This method is the easiest way to delete non-reference scans that are listed in the 

Tree/Component Scans pane. Select a scan that is a non-reference (the Reference 

check box is unchecked) the right-click the column as shown above. Select Delete All 

Scans to Current Reference/Component/Net or Sequence to delete the non-

reference scans for the individual Component/Net or for the entire Sequence. 
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Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Column bar of the Scans pane displays an additional menu for 

performing specific tasks such as sorting or globally deleting items. In the image 

above, the Serial Number column header was right-clicked.  
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Sequence/Component/Pin Editing – Right Click menus  

 

 

Right clicking on the Row header bar of the Tree pane displays an additional menu for 

performing specific tasks such as Add New, Insert, Delete, Repeat, Build (repeat 

but with name incremented by 1), Copy, Paste and Cut. Right clicking works at all 

levels of the Tree pane including Sequence, Component (shown above), Pins, Ranges 

and Scans.  

It is also possible to select groups of components by holding the SHIFT or CTRL keys 

while selecting components in the Tree. To copy, paste, cut or delete groups of 

components, use the Copy, Paste, Cut or Delete Toolbar buttons below the main 

menu.  
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Pin Editing – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Row header bar of the Tree/Pins pane allows for editing of the pin 

information. Select Edit to open the Edit window for the selected pin. 

Note: Some Pin settings can also be edited directly in the Pins grid by clicking the 

appropriate field and modifying the setting.  

Group Edit and Net Edit allow you make changes to the pin of a component and have 

those modifications also change components that have the same number of pins within 

the same Sequence.   

 

 

 

Change the desired settings for the 

current Pin first then select Group 

Edit from the right-click menu (see 

above). Components with the same 

number of pins will be listed. Select 

the components and pins you want to 

be changed. Select the Pin Settings 

check box(s) for the setting(s) you 

want changed. Check the Ranges box 

to match the ranges (this will cause 

signatures to be deleted). Click the 

Update Pins/Ranges button to 
make the changes. 
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Pin Editing 

 

 

Individual pin characteristics can be edited in the Pin Edit window. Net name, 

Channel, Correction steps (for Access Probers) and Scan Pin (enable/disable 

scanning of the pin) can be controlled. For ProTrack or Tracker 3200S, you can control 

the Pulse Generator settings used to enable the Pulse Generator during scanning.  
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Huntron Workstation Buttons Feature 

Huntron Workstation has a built-in feature that allows any Windows based program to 

be started by clicking a button in the Workstation toolbar. It is very easy to use and a 

“Button” can be attached to any Board, Sequence or Component/Net. In this example, 

a Button will be created for a Sequence but the process is the same for the Board and 

Component/Net levels. 

To start, the Sequence edit window is opened by right-clicking the row header for the 

desired sequence. The Edit window will be displayed (see below). 

 

 

 

 

 

 

Select the Buttons… button located on the right side of the Sequence Edit window to 

open the Buttons Setup window. 
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To configure the Button, a Caption (button name displayed in the Tools menu), 

Command Line (the application to be run) and File Path (the file opened by the 

executed application) need to be input into the corresponding fields. A File path will 

not always be required such as instances where a browser is started and pointed to a 

specific URL. In this example, the button will be configured to start the Microsoft Paint 

application and open a small PCB image (see image below). If desired, the icon 

displayed in the main window toolbar can be set by browsing to and setting a path to 

an .ICO (icon) file in the Icon File Path field. Add text that will be displayed when the 

cursor is placed over the Button in Tooltip field. To make the linked file or icon stored 

as part of the Board database, check the Store File and/or Store Icon checkboxes. 
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Click OK to accept the Button. To create additional Buttons, repeat this process and 

click the Add New button in the Button Setup window. 

When Buttons are created, an additional toolbar will appear below the Huntron 

Workstation menu. This toolbar will change according to the level (board, sequence or 

component/net) selected. 

  

 

 

The icon shown can be replaced by selecting an appropriate icon in the Button Setup 

window (the default icon is shown). Click the toolbar button to execute the Button.  
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Technical Support 

For questions or assistance in using Huntron Workstation, contact Huntron at  

800-426-9265, 425-743-3171 or email info@huntron.com.  

 

There is online assistance for Huntron Workstation at 

www.huntron.com/support/workstation.htm. This page will contains software updates, 

a form for reporting software issues and updates to documentation such as this 

tutorial. 

  

mailto:info@huntron.com
http://www.huntron.com/support/workstation.htm


© Huntron, Inc 2019 Version 3 36 

Appendix 1: Huntron Workstation Archive Scans Feature 

The new Archive feature built into Huntron Workstation allows you store and remove 

Sequence scans from the working database to achieve better performance. These 

archived scans are not deleted but saved away in a different database table and can 

be restored at any time. It is very simple to use. 

 

 

 

 

- Select "Archive Board Non-Reference Scans" from the Workstation Edit menu 

- At this point the software will search the database for non-reference scans that were 

part of a Sequence scan and remove them from the active database 

- If you look at the Components Scans tab in the Tree pane, you will see that the 

Reference scans remain 

- To unarchive a scan, select "UnArchive / Delete Board Non-Reference Scans" 

- The Sequence Scan Archive window will be displayed 



© Huntron, Inc 2019 Version 3 37 

 

- You will see the Archive Scans listed where you can select the scan you want to 

restore to your test Sequence. Use the CRTL or Shift keys to select multiple scans if 

needed 

- Click the UnArchive button and the selected scans will be restored to the Sequence 

- Use the Delete button to permanently delete scans that are no longer needed. 

- Close the Sequence Scan Archive window and look at your Component Scans tab and 

you will see that your scans have been restored. 

Keeping your test database small is the best way to get the most out Huntron 

Workstation performance. 

 


